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Introduction
This document describes system requirements, upgrade procedures, new and changed information, and 
caveats for Cisco Aironet PCM/LMC/PCI client adapter firmware release 4.25.30. This release includes 
the new information discussed on page 7 and resolves the caveats listed in the “Resolved Caveats” 
section.
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System Requirements
System Requirements
You must have a Cisco Aironet 340, 350, or 4800 series PC card, LM card, or PCI client adapter to install 
firmware version 4.25.30.

To take advantage of the new features introduced in client adapter firmware release 4.25.30, you must 
install Windows ACU version 5.02.005 or greater and Windows PCM/LMC/PCI card driver version 
8.2.3 or greater. To benefit from the latest security features, your access points must use firmware version 
11.10T or greater.

Note PC, LM, and PCI cards use different drivers and firmware than mini PCI cards.

Note Although firmware version 4.25.30 is compatible with Windows CE, Linux, and Mac OS, the latest 
client utilities for these operating systems (version 2.20 for Windows CE, version 1.6.7 for Linux, 
and version 2.1 for Mac OS) do not support the new features introduced in this firmware release.

Network-EAP Authentication Requires Matching 802.1X Protocol Drafts
In order to use Network-EAP authentication on your wireless network, your client devices and 
infrastructure devices (access points and bridges) must use the same 802.1X protocol draft. Client 
firmware release 4.25.30 supports draft 10 of the 802.1X protocol standard. Therefore, if client devices 
use this version of firmware, an access point or bridge to which they associate must also be configured 
to use draft 10. The table below lists firmware versions for Cisco Aironet products and the drafts with 
which they comply.

Firmware Version Draft 8 Draft 101

1. The functionality in draft 10 is equivalent to the functionality in draft 11, the 
ratified draft of the 802.1X standard.

Client adapters (PCM34x/35x, LMC34x/35x, and PCI34x/35x)

4.13 x —

4.16 x —

4.23 x —

4.25 and later — x

Workgroup bridges (WGB34x/352)

8.58 x —

8.61 and later — x

Access points (AP34x/35x)

11.05 and earlier x —

11.06 and later2

2. The default draft setting in access point and bridge firmware version 11.06 
and later is draft 10.

x x

Bridges (BR352)

11.06 and later2 x x
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Upgrading to a New Firmware Release
If your clients and infrastructure devices do not have matching 802.1X protocol drafts, upgrade the 
firmware in these devices to versions with the same draft number. However, if your access points or 
bridges are using firmware version 11.06 or later, you can use their Authenticator Configuration page to 
select the draft of the 802.1X protocol that they should use. To set the draft for your access points or 
bridges, follow the instructions in the Release Notes for Cisco Aironet Access Points for firmware 
version 11.06 or greater. You can access these Release Notes at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/wireless/airo_350/accsspts/ap350rn/index.htm

Upgrading to a New Firmware Release
This section describes how to upgrade to firmware release 4.25.30.

Determining the Firmware Version
To determine the firmware version that your client adapter is currently using, follow the instructions 
below for your operating system.

In Windows 95, 98, NT, 2000, Me, or XP

Open ACU; then click the Status icon or select Status from the Commands drop-down menu. The 
firmware version is displayed in the Status screen.

In Linux

Open ACU; then select Status from the Commands drop-down menu. The firmware version is displayed 
in the Status screen.

In Mac OS

On Mac OS 9.x, open the Macintosh client utility; then select Status from the File drop-down menu and 
the Link Status tab. The firmware version is displayed in the Status screen.

On Mac OS X, click the Status tab on the Advanced Properties screen. The firmware version is displayed 
in the Status screen.

In Windows CE

Select Start > Programs > Cisco > Load New Firmware. The firmware version is displayed in the 
Select New Firmware screen.
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Upgrading to a New Firmware Release
Upgrade Procedure for Windows, Linux, and Mac OS
To upgrade your client adapter’s firmware on Windows 95, 98, NT, 2000, Me, or XP, Linux, or Mac OS, 
follow the steps below. To upgrade your client adapter’s firmware on Windows CE, go to the “Upgrade 
Procedure for Windows CE” section on page 6.

Note If you downloaded a Windows bundled file and extracted its software files to a folder, locate the 
extracted files, double-click the firmware file (the one that doesn’t specify ACU or the Windows 
operating system), extract its image file (*.img) to a folder, and follow the instructions below 
beginning with Step 9.

Step 1 Use your computer’s web browser to access the following URL:
http://www.cisco.com/public/sw-center/sw-wireless.shtml

Step 2 Locate the section for client adapter firmware.

Step 3 Click the link for your client adapter’s series (for example, 350 Series).

Step 4 Click the latest radio firmware file for your client adapter type.

Note The firmware for PC, LM, and PCI cards is labeled PCM-LMC-PCI.

Note If your wireless network uses LEAP authentication, remember to select a radio firmware file 
of the same draft standard as the access points to which your client adapter will be 
authenticating. 

Note If your wireless network uses EAP-TLS or EAP-MD5 authentication, you must select draft 
10 of the radio firmware.

Step 5 Read and accept the terms and conditions of the Software License Agreement.

Step 6 Select the firmware file to download it.

Step 7 Save the file to a floppy disk or to your computer’s hard drive.

Step 8 Locate the file on your floppy disk or on your computer’s hard drive and use an unzip program to extract 
the image file to a folder.

Step 9 Make sure the client adapter is installed in your computer and is operational.

Step 10 Follow the instructions in one of the subsections below for your specific operating system.

Windows 95, 98, NT, 2000, Me, or XP

Step 1 Open ACU; then click the Load Firmware icon or select Load New Firmware from the Commands 
drop-down menu.

Step 2 Find the location of the new firmware in the Open Window’s Look in box. The default location is 
InstallPath\Firmware, where InstallPath is the directory that ACU was installed in.
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Upgrading to a New Firmware Release
Step 3 Click the firmware image file (*.img) so that it appears in the File name box at the bottom of the Open 
window.

Step 4 Click the Open button. A progress bar displays while the selected image is loaded into the client adapter’s 
Flash memory.

Step 5 Click OK when the “Firmware Upgrade Complete!” message appears. The OK button cannot be selected 
until the process is complete or an error occurs. 

Linux

Step 1 Select Load New Firmware from the Commands drop-down menu.

Step 2 In the File Selection window, find the location of the new firmware in the Files box.

Step 3 Under Files, click the new firmware image (*.img) so it appears in the Selection box at the bottom of 
the window.

Step 4 Click OK to load the firmware image into your client adapter’s Flash memory.

Mac OS

Mac OS 9.x

Step 1 Select Load Firmware from the Edit drop-down menu.

Step 2 In the Firmware window, select the location of the new firmware under Name (for example, Macintosh 
HD).

Step 3 Click the new firmware image (*.img).

Step 4 Click the Open button to load the firmware image into your client adapter’s Flash memory.

Mac OS X

Step 1 Select Download firmware from the File drop-down menu. The File Location screen appears.

Step 2 Click the up and down arrows on the right of the From field and select the location (volume and folder) 
of the new radio firmware file on your hard disk.

Step 3 Click the new firmware image (*.img).

Step 4 Click the Open button. A dialog box appears indicating the progress of the download. The selected 
image is loaded into the client adapter’s Flash memory.

Step 5 Click OK when a message appears indicating the firmware download was successful.
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Upgrading to a New Firmware Release
Upgrade Procedure for Windows CE

Step 1 Use a serial or USB cable to connect your Windows CE device to a laptop or PC running Microsoft 
ActiveSync. A message appears on the Windows CE device indicating that it is connecting to the host. 
After the Windows CE device is connected, the New Partnership window appears on the laptop or PC. 
This window asks if you want to set up a partnership.

Step 2 Perform one of the following:

• If you want to establish a partnership that allows you to synchronize files between the laptop or PC 
and the Windows CE device, select Yes, click Next, and follow the instructions on the screen to 
specify the files to be synchronized and to finish setting up the partnership.

• If you do not want to synchronize files and want to connect as a “guest,” select No and click Next. 
The screen indicates that you are connected as a guest.

Step 3 Use the laptop or PC’s web browser to access the following URL:
http://www.cisco.com/public/sw-center/sw-wireless.shtml

Step 4 Locate the section for client adapter firmware.

Step 5 Click the link for your client adapter’s series (for example, 350 Series).

Step 6 Click the latest radio firmware file for your client adapter.

Note The firmware for PC, LM, and PCI cards is labeled PCM-LMC-PCI.

Note If your wireless network uses LEAP authentication, remember to select a radio firmware file 
of the same draft standard as the access points to which your client adapter will be 
authenticating. 

Step 7 Read and accept the terms and conditions of the Software License Agreement.

Step 8 Select the firmware file to download it.

Step 9 Save the file to a floppy disk or to the hard drive of your laptop or PC.

Step 10 Locate the file using Windows Explorer, double-click it, and extract the image file (*.img) to a folder.

Step 11 In the ActiveSync window on the laptop or PC, click the Explore button to view the files on the Windows 
CE device.

Step 12 Drag and drop the firmware image from Windows Explorer to a location in the ActiveSync window.

Note If your Windows CE device is a PPC running Windows CE 3.0, you must copy the firmware 
image to the My Documents folder or a folder under My Documents.

Step 13 After the file is copied, disconnect the Windows CE device.

Step 14 Make sure the client adapter is installed in your Windows CE device and is operational.

Step 15 On your Windows CE device, select Start > Programs > Cisco > Load New Firmware.

Step 16 Click the Select Firmware button.
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New and Changed Information
Step 17 Find the location of the new firmware image in the Open window.

Step 18 Click the new firmware image file (*.img) so it appears in the Name box at the bottom of the Open 
window.

Step 19 Click OK. If the selected image is loaded successfully into the client adapter’s Flash memory, a 
“Firmware Upgrade Complete!” message appears on the Load New Firmware screen.

New and Changed Information
This section describes new and changed information for release 4.25.30 of the Cisco Aironet client 
adapter firmware.

Ability to Periodically Scan for a Better Access Point Added to ACU
Firmware release 4.25.30 enables the client to look for a better access point if its signal strength becomes 
low and to switch associations if it finds one. This feature is selectable in ACU through the Periodically 
Scan For A Better Access Point parameter on the RF Network screen.

Note This parameter is available only if your client adapter is using ACU version 5.02.005 or greater.

Ability to Select Clear Channel Assessment (CCA)
Firmware release 4.25.30 provides the ability to determine whether the channel on which your client 
adapter will operate is clear prior to the transmission of data. This feature is selectable in ACU through 
the Clear Channel Assessment parameter on the RF Network screen. The following methods are 
available from the parameter’s drop-down list in ACU:

• Firmware Default (XXX) - The CCA mechanism reports that the channel is busy based on the 
default value of the client adapter’s firmware. The firmware’s CCA default value is shown in 
parentheses. For example, the CCA default value for PCM/LMC/PCI card firmware is Car/Cor, and 
the default value for mini PCI card firmware is ED.

• Carrier/Correlation (Car/Cor) - The CCA mechanism reports that the channel is busy upon 
detection of a direct-sequence spread spectrum (DSSS) signal. This signal may be above or below 
the ED threshold.

• Energy Detect (ED) - The CCA mechanism reports that the channel is busy upon detection of any 
energy above the ED threshold.

• ED or Car/Cor - The CCA mechanism reports that the channel is busy upon detection of a DSSS 
signal or any energy above the ED threshold.

Note This parameter is available only if your client adapter is using ACU version 5.02.005 or greater.
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Resolved Caveats
Resolved Caveats
This section describes resolved caveats for client adapter firmware release 4.25.30.

Roaming Issues with Client Adapters
When a client is associated to an access point and then moves away from the access point and closer to 
another access point, the client maintains association with the first access point even if the signal 
strength is very low and the signal quality is poor. If you remove and reinsert the card, the client 
associates to the second access point, and ACU shows a high signal strength and excellent signal quality 
(CSCdv68043). This caveat is resolved in firmware release 4.25.30 and ACU release 5.02.005 with the 
addition of the Periodically Scan For A Better Access Point parameter. When this feature is enabled on 
the ACU RF Network screen (which is the default value), the client will look for a better access point if 
its signal strength becomes low and will switch associations if it finds one.

Poor Throughput with 350 Series PC Card in IBM Laptop
If you install a 350 series PC card in an IBM 600E laptop that is running Windows 98 or 2000, the card 
experiences very poor throughout (CSCdu17477 and CSCdw71765). These caveats are resolved in 
firmware release 4.25.30.

Wideband Japan Channel Set Displays Incorrect Power Levels
The 4800 series client adapters do not display the correct available power levels when programmed to 
the wideband Japan channel set (CSCdv57626). This caveat has been closed because wideband Japan is 
not a valid factory configuration on the 4800A.

Getting Bug Information on Cisco.com
If you are a Cisco registered user, you can use the Cisco TAC Software Bug Toolkit, which consists of 
three tools (Bug Navigator, Bug Watcher, and Search by Bug ID Number) that help you to identify 
existing bugs (or caveats) in Cisco software products. 

Access the TAC Software Bug Toolkit today at the following URL:

http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl

Troubleshooting
For the most up-to-date, detailed troubleshooting information, refer to the Cisco TAC website at the 
following URL: http://www.cisco.com/tac. Select Wireless Technologies under Top Issues.
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Related Documentation
Related Documentation
For more information about 340 and 350 series client adapters, refer to the following documents:

• Cisco Aironet Wireless LAN Client Adapters Installation and Configuration Guide for Windows

• Cisco Aironet Wireless LAN Client Adapters Installation and Configuration Guide for Windows CE

• Cisco Aironet Wireless LAN Client Adapters Installation and Configuration Guide for Linux

• Cisco Aironet Wireless LAN Client Adapters Installation and Configuration Guide for Mac OS

Obtaining Documentation
The following sections explain how to obtain documentation from Cisco Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide Web at the following URL:

http://www.cisco.com

Translated documentation is available at the following URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a CD-ROM package shipped separately 
from the Cisco Aironet Wireless LAN Client Adapters CD that shipped with your product. The 
Documentation CD-ROM is updated monthly and may be more current than printed documentation. The 
CD-ROM package is available as a single unit or as an annual subscription.

Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through the online Subscription 
Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, elsewhere in North 
America, by calling 800 553-NETS (6387).
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Obtaining Technical Assistance
Documentation Feedback
If you are reading Cisco product documentation on Cisco.com, you can submit technical comments 
electronically. Click the Fax or Email option under the “Leave Feedback” at the bottom of the Cisco 
Documentation home page. 

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your document, or 
write to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners can 
obtain documentation, troubleshooting tips, and sample configurations from online tools by using the 
Cisco Technical Assistance Center (TAC) Web Site. Cisco.com registered users have complete access to 
the technical support resources on the Cisco TAC Web Site. 

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that provides immediate, open 
access to Cisco information, networking solutions, services, programs, and resources at any time, from 
anywhere in the world. 

Cisco.com is a highly integrated Internet application and a powerful, easy-to-use tool that provides a 
broad range of features and services to help you to

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

You can self-register on Cisco.com to obtain customized information and service. To access Cisco.com, 
go to the following URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a Cisco product, 
technology, or solution. Two types of support are available through the Cisco TAC: the Cisco TAC 
Web Site and the Cisco TAC Escalation Center.
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Obtaining Technical Assistance
Inquiries to Cisco TAC are categorized according to the urgency of the issue:

• Priority level 4 (P4)—You need information or assistance concerning Cisco product capabilities, 
product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network functionality is noticeably 
impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, affecting significant aspects 
of business operations. No workaround is available.

• Priority level 1 (P1)—Your production network is down, and a critical impact to business operations 
will occur if service is not restored quickly. No workaround is available.

Which Cisco TAC resource you choose is based on the priority of the problem and the conditions of 
service contracts, when applicable.

Cisco TAC Web Site

The Cisco TAC Web Site allows you to resolve P3 and P4 issues yourself, saving both cost and time. The 
site provides around-the-clock access to online tools, knowledge bases, and software. To access the 
Cisco TAC Web Site, go to the following URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco services contract have complete access to 
the technical support resources on the Cisco TAC Web Site. The Cisco TAC Web Site requires a 
Cisco.com login ID and password. If you have a valid service contract but do not have a login ID or 
password, go to the following URL to register:

http://www.cisco.com/register/

If you cannot resolve your technical issues by using the Cisco TAC Web Site, and you are a Cisco.com 
registered user, you can open a case online by using the TAC Case Open tool at the following URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, it is recommended that you open P3 and P4 cases through the Cisco TAC 
Web Site.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses issues that are classified as priority level 1 or priority 
level 2; these classifications are assigned when severe network degradation significantly impacts 
business operations. When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisco TAC 
engineer will automatically open a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, go to the following 
URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the level of Cisco support 
services to which your company is entitled; for example, SMARTnet, SMARTnet Onsite, or Network 
Supported Accounts (NSA). In addition, please have available your service agreement number and your 
product serial number.
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Obtaining Technical Assistance
This document is to be used in conjunction with the documents listed in the “Related Documentation” section.
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